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Dear Student,  

This brief guide is designed to help you understand and use standard practices of 

formatting and citing sources in your papers. The standards are based primarily on Kate 

Turabian’s Manual for Writers, 9th Edition (Turabian) and Kate Turabian’s, Student’s Guide 

to Writing College Papers, 4th Edition.  

   James Lee is to be thanked for writing the original version. Rebekah Ruiz and Joel 

Wingo contributed to earlier revisions of this guide. 

 

Frank J. Correa 

October 2021   
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1.1  

Introduction 
When writing a research paper, the student should follow accepted academic standards for 

citation, style, and format. Citation is the act of carefully and appropriately giving credit to 

those authors who have influenced your ideas, and it also gives your readers the information 

they need to find the source themselves. It is essential that you accurately and properly 

document your sources. Style and format deal with how that information is presented when 

writing a paper. There exist several styles to cite sources, but we will only present one 

approved at VIU—the “Notes-Bibliography” style described in the Chicago Manual of Style and 

Turabian’s Manual for Writers.  The following guide is meant to provide you with basic 

information to get you started.  More detailed information can be obtained by referring to the  

Turabian’s A Manual for Writers, 9th Edition.  We begin with a discussion of basic paper 

formatting.    

1.2  

Document Format 
When using Microsoft Word, most of these settings are set as default.  However, the shaded 

text offers some guidance on how to change a setting.  

Paper Type: 8-½-by-11-inch white paper  

Margins: 1-inch margins on all sides  

Font: Times New Roman  

Font Size: 12-point font size (but 10-point for footnotes)  

Spacing: Double-spaced, except for footnotes, bibliographic entries, and block 

quotations, which are single-spaced.  

O Block Quotations of five or more lines are single spaced with no quotation marks 

and indented from the left, with the same indentation as the beginning of a 

paragraph (.5”). A single blank line is inserted above and below the block 

quotation. 12-point font is used for block quotations.  

Page Number: In the footer, centered, beginning on the first page of the body. The 

title page is not numbered. Page numbers continue through the bibliography, no need 

to restart the numbering.  

MSWord>Insert>Page Numbers…>Bottom of page (footer)>centered>Do not number first 
page>Format>Start at “0”  

Title Page: Separated and on top of paper. Do not insert a blank page following the 

title page.  
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1.3  

Title Page 
The following information should be set apart from the body of the paper and placed on a 

separate page in the order listed. Note: some assignments may not require a separate title 

page. Check with your instructor to see if the title may be placed at the top of the first page 

of text (see Turabian, A.1.4, A.2.1.2, and 22.2.1.1). 

Title of Paper – About a third of the way down the page, centered, bold.   

Subtitle (if applicable) – separated from the title by a colon and a single line of space  

Your Name  

Course Number & Name  

Date – write the name of the month, the day, and the year  

The title page is not numbered  

All words capitalized except articles, coordinating conjunctions, or prepositions (e.g.  

The Meaning of Grace in…). See “headline-style capitalization” in Turabian (22.2.1.1).  

Title Page Example on page 25  
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2.0  

Citing Sources 

Here are some basic questions you might have pondered:  

2.1  

When should I cite? 

1. When using exact words from a source.  

2. When you paraphrase ideas that are associated with the specific source, even if 

you do not quote exact words from it.  

3. When you use any idea, data, or method that can be attributed to an identifiable 

source.  

2.2  

Why should I cite? 

1. To give credit to a source that influenced your work.  

2. To assure readers of the accuracy of your facts.  

3. To help readers find sources to engage in further research.   

4. When the words of others would present strong evidence to back up your reasons 

for your argument.  

5. When you wish to be fair and state exactly what you disagree with.  

6. When you wish to add an authority who agrees with your view.  

7. When the words of others are strikingly unique, compelling, and memorable.  

2.3  

What kind of information will I need to cite? 

You can locate relevant publication information on the first and second pages of most 

published material.    

1. Who wrote or assembled the source?  

Author(s), Editor(s), Translator(s)  
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2. What data identifies the source?  

Title and subtitle  

Title and subtitle of any larger work that contains the source (such as a 

collection, journal, or newspaper)  

Page number(s)  

Volume number  

Issue number  

Edition number  

URL and date you accessed the material, for online sources  

3. Who published the source and when?  

Publisher’s name  

Place of publication (the state is optional–especially unnecessary for 

wellknown places such as Chicago or New York) Date of publication  

In nearly every instance, when you use a quote in your paper, you will need to have a 

footnote to represent it, and also it will be listed in your Bibliography. Abbreviations for 

examples of these three elements will be used below as follows:  

  Q: Quotation  

  N: Note (footnote or parenthetical note)  

  B: Bibliography  

3.0  

In-text Quotations  

There are many ways to incorporate sources into your writing. However, if you are quoting 

four lines or fewer, use quotation marks and run it into your text. If you are quoting five or 

more lines, use a block quotation; see 3.3. The following are examples of in-text quoting with 

four lines or fewer:   

Q: In presenting his case for Christianity, Lee Strobel urges his readers to  

“thoughtfully consider the credibility of the witnesses, carefully sift the 

testimony, and rigorously subject the evidence to common sense and logic.”1 Use an author’s 

full name the first time you mention it, afterwards use only the last name:  

  Q: In presenting his case for Christianity, Lee Strobel urges his readers to 

“thoughtfully consider the credibility of the witnesses, carefully sift the 

testimony, and rigorously subject the evidence to common sense and logic.”1 In 
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particular, Strobel highly encourages his readers to test the eyewitness 

evidence for the historicity of Jesus of Nazareth.2  

You can modify the original quote with square brackets and delete with three dots (ellipses), 

as long as you don’t change the meaning or disturb the grammar:   

  Original quote:  

Q: In response to Blomberg’s argument for the validity of the Gospels, Strobel 

says, “His evidence for their traditional authorship, his analysis of the extremely 

early date of fundamental beliefs in Jesus, his well-reasoned defense of the accuracy 

of the oral tradition, his thoughtful examination of apparent discrepancies – all of his 

testimony had established a solid foundation for me to build on.”3 Words modified:  

Q: In response to Blomberg’s argument for the validity of the Gospels, 

Strobel acknowledges, “[Blomberg’s] evidence for [the Gospels’] traditional 

authorship, his analysis of the extremely early date of fundamental beliefs in Jesus, 

his well-reasoned defense of the accuracy of the oral tradition, his thoughtful 

examination of apparent discrepancies – all of [Blomberg’s] testimony had 

established a solid foundation for me to build on.”3 Words deleted:  

Q: In response to Blomberg’s argument for the validity of the Gospels, Strobel 

acknowledges, “[Blomberg’s] evidence for [the Gospels’] traditional 

authorship, his analysis of the extremely early date of fundamental beliefs in 

Jesus, his well-reasoned defense of the accuracy of the oral tradition, his 

thoughtful examination of apparent discrepancies . . . had established a solid 

foundation for me to build on.”3  

3.3  

Block Quotations 

If you quote five or more lines of a single source, use an indented block quotation. A block 

quotation should be left-aligned, single-spaced, and a line of space should be added before 

and after it. Indent the entire quotation up to the same level as first indented line of a 

paragraph (typically (.5”) and do not use quotation marks. Indent the first line only if it 

begins a paragraph in the original source.  

Q: In discussing faith, Lewis gives a gentle caution to the believer:  

There are certain things in Christianity that can be understood from the 

outside, before you have become a Christian. But there are a great many things 

that cannot be understood until after you have gone a certain distance along 

the Christian road. These things are purely practical, though they do not look  

as though they were. They are directions for dealing with particular crossroads 

and obstacles on the journey and they do not make sense until a man has 

reached those places. 1    
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3.4  

Quoting the Bible 

Citing the Bible is unique for two reasons: parenthetical should be used instead of footnotes, 

and you do not need to include an entry for the Bible in the Bibliography. The first time you 

quote the Bible, add a footnote stating, “Unless otherwise noted, all Scripture references are 

taken from the [version name].” Whenever you reference a different version, or if you do not 

wish to identify a “default” version for your majority of your references, include the 

abbreviation of the version in the parenthetical note, e.g. (Matt. 29:18-20 NKJV). No comma 

is used between the reference and the version, and the final period is placed after the 

parenthetical note containing the Scripture reference. A comma and a space should be used 

to separate non-continuous verses in a single reference, and a semicolon should separate 

multiple references, e.g. (John 3:16, 18 NKJV; John 1:1 ESV).   

3.5  

Quoting Shorter Bible Passages 

When you quote a verse or verses from the Bible amounting to less than five lines, use 

quotation marks. You may wish to refer to the author or to the book in your text.  

Example:  

Both Peter and Paul unashamedly defend the divine authority of Scripture.  Peter 

declares that “no prophecy of Scripture came about by the prophet’s own 

interpretation.  For prophecy never had its origin in the will of man, but men spoke 

from God as they were carried along by the Holy Spirit” (2 Pet. 1:20-21).  Looking 

back on the whole Old Testament, the apostle Paul wrote, “All Scripture is God-

breathed and is useful for teaching, rebuking, correcting, and training in 

righteousness, so that the man of God may be thoroughly equipped for every good 

work” (2 Tim. 3:16-17).  
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3.6  

Quoting Longer Bible Passages 

When quoting verses that amount to more than five lines, a use block quotation.   

Example:  

Q: Paul encourages the Ephesians to   

Look carefully then how you walk, not as unwise but as wise, making the best 

use of the time, because the days are evil. Therefore do not be foolish, but 

understand what the will of the Lord is.  And do not get drunk with wine, for 

that is debauchery, but be filled with the Spirit, addressing one another in 

psalms and hymns and spiritual songs, singing and making melody to the Lord 

with your heart … (Eph. 5:15–19 ESV)  

In a block quotation, no period follows the reference itself.  

When quoting many verses of Scripture, do not include a verse number for each verse in the 

quotation.   

Here is a list of abbreviations for a number of versions:   

3.7  

Bible Version Abbreviations 
Well Known Formal Equivalent Versions  

  Full Traditional Name       Abbreviation  

 English Standard Version      ESV  

King James Version or Authorized Version  KJV or AV  

New American Standard Bible (1995)  NASB95  

New American Standard Bible (1971)  NASB  

 New King James Version      

Other Versions  

NKJV  

 Amplified Bible        AB  

 American Revised Version      ARV  

 American Standard Version     ASV  

 Contemporary English Version    CEV  

 Douay Version         DV  

 English Revised Version      ERV  

 Good News Translation      GNT  

 Holman Christian Standard Bible    HCSB or CSB  

 Jerusalem Bible  (1966)     JB  

 The Living Bible        LB  

 The Message Bible        MSG  
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The NET Bible (New English Translation)  NET  

 New American Bible       NAB  

 New Century Version       NCV  

 New English Bible        NEB  

 New Living Translation      NLT   

 New International Version (2011)    NIV  

 New International Version (1984)    NIV84  

 New Jerusalem Bible (1985)     NJB  

 New Revised Standard Version    NRSV  

 The New Testament in Modern English  Phillips  

New World Translation (Jehovah’s Witnesses) NWT   

 Revised Standard Version      RSV  

 Todays New International Version    TNIV  

 Vulgate          Vulg.  

 Wuest Expanded Translation     Wuest  

 

 

 

3.8  

Bible Book Abbreviations 
Books of the Bible should be abbreviated in footnotes and in parenthetical citations, but not 

in in the text of your work. When you refer to an entire book or to whole chapters from the 

Bible, write the full name of the book, do not abbreviate, italicize, or underline.  

Example:   

Genesis 2-3 records the creation, temptation, and fall of humankind.  

While in prison, Paul penned First Corinthians.   
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Old Testament Books  
Psalm(s) Ps. (Pss.) 

Proverbs Prov. 

Ecclesiastes Eccl. 

Song of Solomon Song of Sol. 

Isaiah Isa. 

Jeremiah Jer. 

Lamentations Lam. 

Ezekiel Ezek. 

Daniel Dan. 

Hosea Hos. 

Joel Joel 

Amos Amos 

Obadiah Obad. 

Jonah Jon. 

Micah Mic. 

Nahum Nah. 

Habakkuk Hab. 

Zephaniah Zeph. 

Haggai Hag. 

Zechariah Zech. 

Malachi Mal. 

Full Name Abbreviation 

Genesis Gen. 

Exodus Exod. 

Leviticus Lev. 

Numbers Num. 

Deuteronomy Deut. 

Joshua Josh. 

Judges Judg. 

Ruth Ruth 

1 Samuel 1 Sam. 

2 Samuel 2 Sam. 

1 Kings 1 Kings 

2 Kings 2 Kings 

1 Chronicles 1 Chron. 

2 Chronicles 2 Chron. 

Ezra Ezra 

Nehemiah Neh. 

Esther Est. 

Job Job 
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New Testament Books 

Full Name Abbreviation 

       Matthew Matt. 

Mark Mark 

Luke Luke 

John John 

Acts Acts 

Romans Rom. 

1 Corinthians 1 Cor. 

2 Corinthians 2 Cor. 

Galatians Gal. 

Ephesians Eph. 

Philippians Phil. 

Colossians Col. 

1 Thessalonians 1 Thess. 

2 Thessalonians 2 Thess. 

1 Timothy 1 Tim. 

2 Timothy 2 Tim. 

Titus Titus 

Philemon Philem. 

Hebrews Heb. 

James James 

1 Peter 1 Pet. 

2 Peter 2 Pet. 

1 John 1 John 

2 John 2 John 
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3 John 3 John 

Jude Jude 

Revelation Rev. 

 

4.0  

Introduction to Footnotes 
Whenever you use an outside source, you must write a note for that source in the form of a 

long or short footnote. Notice, some quotations above use a superscript number at the end of 

the sentence to signal that you have used a source (the superscript is that number at the end 

of the quotation mark or sentence that sits slightly above the rest of the sentence, e.g. 

123456). The superscript informs the reader that information about that source can be found in 

the footnote of the paper. The footnote corresponds to the number of the superscript and 

provides relevant information about that source as well as a relevant page number. The first 

time you note a source, use a long footnote, then use a short note or parenthetical note 

afterwards for the same source. A long footnote contains full publication information, 

whereas the short does not. The short note will be discussed later (see 5.0 - 5.7) as well as 

the parenthetical note (see 5.6 below, or 3.4 for Scripture references).  

Use 10-point font for footnotes, and indent the number and the first line, with the same 

indentation as the first line of a paragraph in the body.   

Single-space footnotes, but if more than one footnote appears on a page, insert a blank line 

of space between each footnote.  

Note: Although Turabian calls for a superscript number at the end of a quote in the body and 

a full-size number followed by a period and a space at the beginning of the footnote, it is 

permissible to use your word processor software’s automatic footnote settings for 

numbering. Most programs use a superscript at the beginning of the footnote, and/or do not 

include a period following the number.  

4.1  

MSWord, Apple, & Open Office shortcuts 

Microsoft Word and other software programs have made it easy to include a footnote into 

your paper.  At the end of your quote, paraphrase, or summary, follow the procedure to 

include a footnote:  

MSWord>Insert>Footnote  
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Apple Pages>Insert>Footnote  

Open Office Writer> >Insert>Footnote/Endnote  

4.2  

Here are the patterns and some examples of how to make a long footnote:  

 

Long Note - Single Author 

N:  Note Number.  Author’s First Name and Last Name, Title of Book: Subtitle of Book 

(Place of Publication, state is optional: Publisher’s Name, Date of Publication), Page-Page.   

1. Lee Strobel, The Case For Christ: A Journalist’s Personal Investigation of the 

Evidence for Jesus (Grand Rapids, Michigan: Zondervan, 1998), 18-19.  

4.3  

Long Note - Two Authors 
N:  Note Number.  1st Author First Name and Last Name and 2nd Author First Name and 

Last Name, Title of Book: Subtitle of Book  (Place of Publication: Publisher’s Name, Date of 

Publication), Page-Page.  

2. Norman Geisler and Ron Rhodes, Conviction Without Compromise: Standing Strong 

in the Core Beliefs of the Christian Faith (Eugene, Oregon: Harvest House Publishers, 2008), 

45-46.  

4.4  

Long Note - Three or More Authors 
N:  Note Number.  1st Author First Name and Last Name, 2nd Author First and Last 

Name, and 3rd Author First and Last Name, Title of Book: Subtitle of Book (Place of 

Publication: Publisher’s Name, Date of Publication), Page-Page.  

3. William Lane Craig, James P. Moreland, and Francis Beckwith, To Everyone an 

Answer: A Case for the Christian Worldview (Downers Grove, Illinois: Intervarsity Press, 

1998), 10-11.   

N:  Note Number.  1st Author First Name and Last Name, 2nd Author First and Last 

Name, 3rd Author First and Last Name, and 4th Author First and Last Name, Title of Book:  

Subtitle of Book (Place of Publication: Publisher’s Name, Date of Publication), Page-Page.  
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4. John Hick, Clark H. Pinnock, Alister E. McGrath, and R. Douglas Geivett, Four 

Views on Salvation in a Pluralistic World (Grand Rapids, Michigan: Zondervan Publishing 

House, 1995), 95-96.  

4.5  

Long Note - Editor or Author(s) plus Editor 
Editor Only:  

N:  Note Number.  Editor’s First and Last Name, ed., Title of Book: Subtitle of Book. 

(Place of Publication: Publisher’s Name, Date of Publication), Page-Page.  

5. Ronald F. Youngblood, ed., Nelson's New Illustrated Bible Dictionary: 

Completely Revised And Updated Edition. (Nashville, Tennessee: Thomas Nelson, 1990), 33-

34.   

Author plus Editor:  

N:  Note Number.  Author’s First and Last Names, Title of Book: Subtitle of Book, ed. 

Editor’s First and Last Names (Place of Publication: Publisher’s Name, Date of Publication), 

Page-Page.  

6. Lewis Sperry Chafer, Systematic Theology Abridged, ed. John F. Walvoord  

(Wheaton, Illinois: Victor Books, 1974), 76.  

4.6  

Long Note - Edition Number 

N:  Note Number. Author’s First and Last Name, Title of Book: Subtitle of Book, 

Edition Number ed.  (Place of Publication: Publisher’s Name, Date of Publication), Page-Page.  

7. Warren W. Wiersbe, Be Joyful: A Practical Study of Philippians, 15th ed. (Wheaton, 

Illinois: Victor Books, 1974), 56-57.  

4.7  

Long Note - Journal Article in Print 

Reminder: the title of the article is set in quotation marks, and the title of the journal is 

italicized.  

N: Note Number.  Author’s First and Last Name, “Title of Article: Subtitle of Article,” 

Title of Journal Volume Number (Date of Publication): Page-Page.  

8. Norman L. Geisler, “Jesus and Muhammed in the Qur’an: A Comparison and 

Contrast,” Southern Baptist Journal of Theology 8, no. 1 (Spring 2004): 50.  
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4.8  

Long Note - Journal Article Online 

N: Note Number.  Author’s First Name and Last Names,  “Title of Article: Subtitle of 

Article,” Title of Journal Volume Number (Date of Publication), under “Descriptive Locator,” 

URL (accessed Date of Access).  

9. Andrew Bernhard, “Dating Early Christian Gospels,” Journal of Biblical Studies 1, 

no. 4 (Oct-Dec 2001), under “Articles,” http://journalofbiblicalstudies.org/Issue4/Articles/ 

dating_early_ christian_gospels.htm  (accessed September 20, 2010).  

 

Note: Turabian 9th edition discouraged accessed date unless there is no publication date of 

modified date posted. 

4.9  

Long Note – Online Sources 

Even though many online websites lack relevant information for a proper citation, try to 

include as much pertinent information as possible.  

N: Note Number. Author’s First and Last Name, “Title of the Web Page,” Title or 

Owner of the Site, URL (accessed Date).  

10. Charlie Campbell, “Twenty Reasons Christians Believe Jesus is God,” The Always 

Be Ready Apologetics Ministry,  http://www.alwaysbeready.com/ index.php?option= 

com_content& task=view&id=94&Itemid=0 (accessed September 20, 2010).  
 

4.10  

Long Note - Lectures 

N: Note Number. Speaker’s First and Last Name, “Title of Lecture,” (Sponsorship, 

Place and Location of Lecture, Date of Lecture).   

11. Chuck Smith, “A Venture in Faith,” (Friday Lectures, Calvary Chapel Bible College, 

Murrieta, CA, September 03, 2010).  

4.11                                        E books 

Cite by chapter of section number, not location. 

1.Gaddis, The Cold War: A New History, chap. 4, sec 1, para 5. 
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5.0  

Short Footnotes 
The first time you use a footnote for a particular source, make it long.  If the same source is 

used again, then make it shorter.  Include the author’s last name and at least one to four 

distinctive words from the title, and page numbers.   

5.1  

Short Note - Single Author  

N: Note Number. Author’s Last Name, Shortened Title, Page-Page.  

Example   

Here is the quote:  

Q:   In presenting his case for Christianity, Lee Strobel urges his readers 

to “thoughtfully consider the credibility of the witnesses, carefully sift 

the testimony, and rigorously subject the evidence to common sense 

and logic.”1  

Long footnote - the first time it is cited.  

N:   1.  Lee Strobel,  The Case For Christ: A Journalist’s Personal 

Investigation of the Evidence for Jesus (Grand Rapids: Zondervan, 

1998), 18.  

Short footnote - when the source is cited again.  

N:   2. Strobel, Case For Christ, 92-93.  

5.2  

Short Note - Two Authors 
N: Note Number. 1st Author’s Last Name and 2nd Author’s Last Name, Shortened Title, 

PagePage.  

Example   

Here is the quote:  

Q:   Geisler and Rhodes’ philosophy on Christian doctrine can 

be distilled into one essential dictum, “In essentials, unity; in 
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nonessentials, liberty; and in all things, charity.”5 Long footnote - the 

first time it is cited.  

N:   5. Norman Geisler and Ron Rhodes, Conviction without  

Compromise: Standing Strong in the Core Beliefs of the Christian Faith, 

(Eugene: Harvest House Publishers, 2008), 16.  

Short footnote - when it is cited again.  

N:   6. Geisler and Rhodes, Conviction, 121-123.  

5.3  

Short Note - Three Authors 
N:  Note Number.  1st Author Last Name, 2nd Author Last Name, and 3rd Author Last 

Name, Shortened Title, Page-Page.  

 Example     

Long footnote - the first time it is cited  

9. Jack Bartlett Rogers, Ross Mackenzie, and Louis Weeks, 

Case Studies in Christ and Salvation (Philadelphia, Pennsylvania:  

Westminster Press, 1977), 25-26.  

Short footnote - when it is cited again  

10. Rogers, Mackenzie, and Weeks, Case Studies, 28.  

5.4  

Short Note - Four or More Authors 

   Example  

Long note – the first time it is cited  

11. John Hick, Clark H. Pinnock, Alister E. McGrath, and R. 

Douglas Geivett, Four Views on Salvation in a Pluralistic World (Grand 

Rapids, Michigan: Zondervan Publishing House, 1995), 95-96.  

Short footnote – when it is cited again  

12. Hick et al., Four Views, 102.  
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5.5  

Short Note - Journal Article in Print 

N: Note Number.  Author’s Last Name, “Shortened Title of Article,” Page-Page.  

Example   

Long Note  

13. Norman L. Geisler, “Jesus and Muhammad in the Qur’an: A 

Comparison and Contrast,” Southern Baptist Journal of Theology 8, no. 1 (Spring 

2004): 50.  

Short Note  

14. Geisler, “Jesus and Muhammad,” 55.  

5.6  

Parenthetical Notes: Many References to a Few Sources 

If you plan on referring frequently to numerous passages from only a few sources (three or 

fewer), then it is cleaner and more readable to use parenthetical notes after the first 

footnote. The parenthetical note substitutes for the footnote and is placed where the 

superscript number would be. The difference, however, is the parenthetical note is in its 

shortened form and is placed within parenthesis and before the end punctuation. There are 

three types listed below:  

Page number only:  

If you mention the author and title in your writing, and if readers can easily identify 

the specific source, then you may only include the page number in the parenthesis.  

Example  

After examining the corroborating evidence for Jesus, Strobel now 

focuses his journalistic eyes upon the scientific evidence in the Case for 

Christ (122).  

Author and page number:  

If readers cannot identify the author, and if you have already once cited the author, 

then include the author’s last name and page number in the parenthesis.  

Example  

As noted, the overwhelming archeological evidence remarkably affirms 

the New Testament’s historical accuracy (Strobel, 143).  
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Title and page number:  

If you have cited more than one work by the same author, and if readers can easily 

identify the author, then only include the shortened title and page number in the 

parenthesis.  

Example  

After examining the evidence for the case for Christ, Strobel moves on 

to an examination of objections to the Christian faith (The Case for 

Faith, 5)  

5.7  

Ibid. 

Turabian 9th edition discourages the traditional use of Ibid. Instead use the short 

footnote.  

Geisler, “Jesus and Muhammad,” 81.  

Geilser, 95.   Note: if page number is same as prior footnote, omit the page number. 

6.0  

The Bibliography 
In addition to being quoted in-text and given a footnote, most sources must be listed in a 

bibliography at the end of the paper on a separate page with the second line indented.  Some 

types of sources, however, are omitted; do not include these sources in the Bibliography:  

• The Bible and other sacred works  

• Well-known dictionaries and encyclopedias (e.g. Webster’s)  

• Newspaper articles  

• Email  

• Unpublished interviews  

• Pamphlets  

• Artwork, live performances, television broadcasts  

For all other sources, do include them in the Bibliography. A bibliographic entry will have 

much of the same information found in a long note, with some slight differences. Like the 

patterns for a note, the patterns for a bibliographic entry are precise and must be followed 

exactly. Minute details for order, punctuation, capitalization, italics, indentation, to mention 

a few details, must be observed.  Also, the list must be alphabetized by last name. Do not 

restart the page numbering for the bibliography.  

6.1  
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Bibliography - Single Author 

B: Author’s Last Name, Author’s First Name.  Title of Book: Subtitle of Book. Place of 

Publication: Publisher’s Name, Date of Publication.  

  Example:  

Lightfoot, Niel R.  How We Got The Bible. Grand Rapids, Michigan: Baker Books, 2006.  

6.2  

Bibliography - Two Authors 

B: 1st Author Last Name, 1st Author First Name, and 2nd Author First Name 2nd Author Last 

Name. Title of Book: Subtitle of Book. Place of Publication: Publisher’s Name, Date of 

Publication.  

  Example:  

Feinberg,  John S., and Paul D. Feinberg. Ethics for a Brave New World.  Wheaton, 

Illinois: Crossway Books, 1993.  

6.3  

Bibliography - Three Authors 
B: 1st Author Last Name, 1st Author First Name, and 2nd Author First Name 2nd Author Last 

Name, and 3rd Author First Name 3rd Author Last Name. Title of Book: Subtitle of 

Book. Place of Publication: Publisher’s Name, Date of Publication.  

  Example:  

Craig, William Lane, and James P. Moreland, and Francis Beckwith.  To Everyone an 

Answer: A Case for the Christian Worldview.  Downers Grove, Illinois: 

Intervarsity Press, 2004.  

6.4  

Bibliography - Four Authors 

B: 1st Author Last Name, 1st Author First Name, and 2nd Author First Name 2nd Last Name, and  

3rd Author First Name 3rd Author Last Name, and 4th Author First Name 4th Author Last 

Name. Title of Book: Subtitle of Book. Place of Publication: Publisher’s Name, Date of 

Publication.  
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  Example:  

Geisler, Norman L., and Michael Scott Horton, and Stephen M. Ashby, and Matthew J. 

Pinson. Four Views on Eternal Security. Grand Rapids, Michigan: Zondervan 

Publishing House, 2002.  

6.5  

Bibliography - Editor or Author(s) plus Editor 

Editor Only  

B: Editor’s Last Name, Editor’s First Name, ed.  Title of Book: Subtitle of Book. Place of 

Publication: Publisher’s Name, Date of Publication.  

  Example:  

Youngblood, Ronald F., ed.  Nelson's New Illustrated Bible Dictionary: Completely  

Revised And Updated Edition. Nashville, Tennessee: Thomas Nelson, 1995.   

Author plus Editor:  

B: Author’s Last Name, Author’s First Name.  Title of Book: Subtitle of Book. Edited by 

Editor’s First and Last Names.  Place of Publication: Publisher’s Name, Date of 

Publication.  

  Example:  

Chafer, Lewis Sperry. Systematic Theology, Abridged. Edited by John F. Walvoord.  

Wheaton, Illinois: Victor Books, 1988.  

6.6  

Bibliography - Edition Number 

B: Author’s Last Name, Author’s First Name.  Title of Book: Subtitle of Book. Edition Number 

ed.  Place of Publication: Publisher’s Name, Date of Publication.  

  Example:  

Pentacost, J. Dwight. Design for Discipleship.  14th ed. Grand Rapids, Michigan: 

Zondervan Publishing House, 1980.  
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6.7  

Bibliography - Journal Article in Print 

B: Author’s Last Name, Author’s First Name.  “Title of Article: Subtitle of Article.” Title of 

Journal Volume Number (Date of Publication): YY-YY.  

  Example:  

Charles, J. Daryl.  “Returning to Moral ‘First Things’: The Natural-Law Tradition and 

Its Contemporary Application,” Philosophia Christi 6, no. 1 (2004): 59-76.  

6.8  

Bibliography - Journal Article Online 

B: Author’s Last Name, Author’s First Name. “Title of Article: Subtitle of Article.” Title of 

Journal Volume Number (Date of Publication). URL (accessed Date).  

  Example:  

Bernhard, Andrew. “Dating Early Christian Gospels.” Journal of Biblical Studies 1, no. 

4 (Oct-Dec 2001).  http://journalofbiblicalstudies.org/Issue4/Articles/ 

dating_early_ christian_ gospels.htm  (accessed September 20, 2010).  

6.9  

Bibliography - Website 

B: Author’s Last Name, Author’s First Name.  “Title of the Web Page.” Title or Owner of the 

Site. URL (accessed Date).  

  Example:  

Campbell, Charlie.  “Twenty Reasons Christians Believe Jesus is God.”  The Always Be 

Ready Apologetics Ministry. http://www.alwaysbeready.com/ 

index.php?option= com_content&task=view&id=94&Itemid=0 (accessed 

September 20, 2010).  

6.10  

Bibliography - Lectures 

B: Speaker’s Last Name, First Name.  “Title of Lecture.”  Name of Event.  Sponsor, Location 

of Lecture, Date of Lecture.  

  Example:  
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Smith, Chuck. “A Venture in Faith.” Friday Lectures. Calvary Chapel Bible College, 

Murrieta, California, September 03, 2010.    

6.11  

Bibliography - The Bible and Other Sacred Texts 

No bibliographic entry should be included for the Bible or other sacred texts.  Please see 

sections 3.4-3.8 on how to cite the Bible.  

6.12  

Bibliography Example:  
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Recommended Resources 

Turabian: The Easy Way by Houghton and Houghton (based on 7th edition but still very 

handy) 

Quality Research papers for Students of Religion and Theology by Nancy Vyhmeister 

The Elements of Style by William Strunk and E. B. White. 

Research Strategies by William Badke 

The Craft of Research, Fourth Edition (Chicago Guides to Writing, Editing, and 

Publishing)  by Gregory G. Colomb, Joseph Bizup, Joseph M. Williams, Wayne C. 

Booth, William T. FitzGerald 
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http://www.grammarbook.com/english_rules.asp 
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